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“Si, por lo tanto, la ciencia actual apunta en su perplejidad a logros técnicos para «probar» 

que tratamos con un «auténtico orden» dado en la naturaleza, parece que ha caído en un círculo 

vicioso, que cabe formular así: los científicos formulan sus hipótesis para disponer sus experimentos 

y luego usan dichos experimentos para comprobar sus hipótesis; durante toda esta actividad está 

claro que tratan con una naturaleza hipotética. 

Dicho con otras palabras, el mundo del experimento siempre parece capaz de convertirse 

en una realidad hecha por el hombre, y esto, que acrecienta el poder del hombre para hacer y 

actuar, incluso para crear un mundo, mucho más allá de lo que cualquier época anterior se atrevió 

a imaginar en sueños y fantasías, por desgracia hace retroceder una vez más al hombre – y ahora 

de manera más enérgica – a la cárcel de su propia mente, a las limitaciones de los modelos que él 

mismo creó.” 

- Hannah Arendt, The Human Condition, 1958. 

 

 

 

 

 

 

 



Índice  
Lista de Figuras ....................................................................................................................... 1 

Lista de Tablas ........................................................................................................................ 2 

Abreviaturas y acrónimos ....................................................................................................... 3 

Resumen ................................................................................................................................. 4 

I Introducción .......................................................................................................................... 5 

1. Los citocromos P450 ....................................................................................................... 5 

1. 1 Los CYP1A catalizan endobióticos y xenobióticos ....................................................... 6 

1. 1. 1 Función de CYP1A1 ............................................................................................... 7 

1. 1. 2 Función de CYP1A2 ............................................................................................... 7 

1. 2 Vía del receptor de hidrocarburo de arilo ................................................................... 9 

1. 3 Flavonoides ................................................................................................................ 12 

1. 3. 1 Las flavonas y sus propiedades bioquímicas ...................................................... 13 

II Planteamiento del problema ............................................................................................. 14 

III Hipótesis general .............................................................................................................. 15 

IV Objetivo general ............................................................................................................... 15 

V Materiales y métodos ........................................................................................................ 15 

5. 1 Modelo biológico ....................................................................................................... 15 

5. 2 Tratamientos .............................................................................................................. 15 

5. 3 Obtención de la fracción microsomal a partir de hígado de rata .............................. 17 

5. 4 Cuantificación de proteínas totales de la fracción microsomal de hígado de rata ... 18 

5. 5 Evaluación de la O-desalquilación de etoxiresorufina (EROD) y metoxiresorufina 

(MROD) por la fracción microsomal de hígado de rata .................................................... 18 

5. 6 Estudios de acoplamiento molecular (Molecular docking) ....................................... 18 

5. 7 Análisis estadístico ..................................................................................................... 20 

VI Experimento A .................................................................................................................. 20 

6. 1 Hipótesis ..................................................................................................................... 20 

6. 2 Objetivos .................................................................................................................... 20 

6. 3 Resultados .................................................................................................................. 20 

6. 3. 1 Reacción de O-desalquilación de la etoxirresorufina con CYP1A1 por flavona . 21 

6. 3. 2 Reacción de O-desalquilación de la metoxirresorufina con CYP1A2 por flavona

 ....................................................................................................................................... 21 



6. 4 Conclusión .................................................................................................................. 23 

VII Experimento B ................................................................................................................. 23 

7. 1 Hipótesis ..................................................................................................................... 23 

7. 2 Objetivo ...................................................................................................................... 23 

7. 3 Resultados .................................................................................................................. 23 

7. 3. 1 Reacción de O-desalquilación de la etoxirresorufina con CYP1A1 por 

flavona/B[a]P ................................................................................................................. 23 

7. 3. 2 Reacción de O-desalquilación de la metoxirresorufina con CYP1A2 por 

flavona/B[a]P ................................................................................................................. 24 

7. 4 Conclusión .................................................................................................................. 26 

VIII Experimento C ................................................................................................................ 26 

8. 1 Hipótesis ..................................................................................................................... 26 

8. 2 Objetivo ...................................................................................................................... 26 

8. 3 Resultados .................................................................................................................. 26 

8. 3. 1 Estudios de acoplamiento molecular ................................................................. 26 

IX Discusión ........................................................................................................................... 29 

X Conclusiones ...................................................................................................................... 34 

XI Perspectivas ...................................................................................................................... 34 

XII Referencias ...................................................................................................................... 35 

XIII Anexos ............................................................................................................................ 42 

A-I Estudios de acoplamiento molecular. ......................................................................... 42 

A-II Datos estadísticos. ...................................................................................................... 43 

A-III Secuencia de aminoácidos para las isoformas de CYP1A.......................................... 44 

A-IV Resultados del docking molecular. ........................................................................... 44 

 

 



1 
 

Lista de Figuras 

Figura 1. Esquema representativo de la reacción general mediada por los citocromos P450 

(CYP). 

Figura 2. Descripción gráfica de la nomenclatura para los CYP. 

Figura 3. Diagrama de la biotransformación de benzo[a]pireno. 

Figura 4. Diagrama de la vía del AHR. 

Figura 5. Esquema de ligandos clásicos y no clásicos de AHR. 

Figura 6. Estructura fundamental de la flavona con los nombres de los anillos y la posición 

de sus carbonos. 

Figura 7. Esquema representativo de las flavonas más abundantes en las plantas. 

Figura 8. Esquema que describe los diferentes tratamientos aplicados. 

Figura 9. Efecto del tratamiento con flavona en la O-desalquilación de la etoxirresorufina 

por CYP1A1 y el efecto del tratamiento con flavona en la O-desalquilación de la 

metoxirresorufina por CYP1A2. 

Figura 10. Efecto del tratamiento con flavona en la O-desalquilación de la etoxirresorufina 

por CYP1A1 y el efecto del tratamiento con flavona en la O-desalquilación de la 

metoxirresorufina por CYP1A2. 

Figura 11. Acoplamiento entre CYP1A1 de rata con flavona. 

Figura 12. Acoplamiento entre CYP1A2 rata con flavona. 

Figura 13. Acoplamiento entre AHR de rata con flavona. 

Figura A1. Acoplamiento entre CYP1A1 humano con flavona. 

Figura A2. Acoplamiento entre CYP1A2 humano con flavona. 

Figura A3. Acoplamiento entre AHR de humano con flavona. 



2 
 

Lista de Tablas 

Tabla 1. Funciones de las isoformas de CYP1A. 

Tabla 2. Esquema de administración de tratamientos. 

Tabla 3. Esquema de las simulaciones experimentales efectuadas para el acoplamiento 

molecular. 

Tabla 4. Porcentaje de similitud de aminoácidos entre las proteínas evaluadas, obtenidas 

con BLAST. 

Tabla A1. Procedimiento para realizar una prueba de acoplamiento molecular. 

Tabla A2. Datos obtenidos de actividad específica de CYP1A1 (pmol/mg proteína * min). 

Tabla A3. Datos obtenidos de actividad específica de CYP1A2 (pmol/mg proteína * min).  

Tabla A4. Secuencia de aminoácidos para las isoformas de CYP1A 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



3 
 

Abreviaturas y acrónimos 

AHR 

ARNT 

B[a]P 

BLAST 

BPDE 

CPR 

CYP 

EDTA 

EROD 

HSP90 

IH 

MROD 

NADH 

PAH 

XAP2 

XRE 

 

 

Receptor de hidrocarburos de arilo 

Receptor nuclear del AHR 

Benzo[a]pireno 

Herramienta básica de búsqueda de alineación local 

Benzo[a]pireno diolepóxido 

Citocromo P450 reductasa 

Citocromos P450 

Ácido etilendiaminatetraacético 

Reacción de O-desalquilación de la etoxirresorufina 

Proteína de choque térmico 90 

Interacciones hidrofóbicas 

Reacción de la O-desalquilación de la metoxirresorufina 

Nicotinamida dinucleótido 

Hidrocarburos aromáticos policíclicos 

Proteína 2 asociada a proteína X 

Elementos de respuesta a xenobióticos 

 

 

 

 

 

 

 



4 
 

Resumen 

Los flavonoides son la subclase más amplia de polifenoles con cerca de 9 000 moléculas 

presentes en la mayoría de los grupos vegetales. Dentro de este grupo se encuentran las 

flavonas, que son los flavonoides menos complejos. Debido a su amplia presencia las 

ingerimos constantemente en nuestra alimentación a través de frutas y vegetales. Los 

citocromos P450 (CYP) son una superfamilia de monooxigenasas hemotioladas presentes 

en la mayoría de los organismos, que biotransforman una amplia variedad de endobióticos 

y xenobióticos; la subfamilia CYP1A incluye dos genes para las isoformas CYP1A1 y CYP1A2 

que biotransforman principalmente xenobióticos con estructuras anilladas, estructuras 

heterocíclicas e hidrocarburos aromáticos policíclicos en fármacos, contaminantes 

ambientales y metabolitos secundarios de origen vegetal. Asimismo, están implicados en 

procesos de activación de procarcinógenos que podrían tener efectos genotóxicos. En 

varios modelos se ha reportado que las flavonas como apigenina, chrysina, diosmetina, 

galangina y quercitina presentan diversas propiedades antiinflamatorias, antioxidantes y 

anticarcinogénicas a causa de sus efectos sobre la inducción de la expresión de CYP1A1 y 

CYP1A2 y al mismo tiempo, su inhibición en la actividad enzimática. En este trabajo se 

evaluaron los efectos de la flavona (2-fenil-1,4-benzopirona) que carece de grupos 

sustituyentes, sobre la actividad de CYP1A1 y CYP1A2 in vivo en microsomas hepáticos en 

modelo de Rattus norvegicus y se proponen las posibles interacciones in silico entre la 

flavona y sus sustratos en CYP1A y el receptor de hidrocarburos de arilo a través de estudios 

de acoplamiento molecular. 
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I Introducción 

1. Los citocromos P450 

Los citocromos P450 (CYP) son una superfamilia de monooxigenasas hemotioladas, 

conformadas por un grupo hemo y átomos de azufre, con los que biotransforman una 

amplia variedad de moléculas endógenas (endobióticos), tales como esteroides, ciertas 

vitaminas, ácidos biliares, ácidos grasos, prostaglandinas y retinoides. Asimismo, moléculas 

exógenas (xenobióticos) como fármacos, contaminantes ambientales y metabolitos de 

origen vegetal (1-3). 

La reacción catalizada por los CYP consiste en la transferencia de un átomo de oxígeno al 

sustrato, a partir de oxígeno diatómico (O2), lo que incrementa su solubilidad facilitando su 

biotransformación y su excreción a través de la orina o bilis (1, 2). 

La energía indispensable para el rompimiento de enlace entre oxígenos se obtiene de la 

transferencia de dos electrones procedentes de NADH asistido por NADH-citocromo P450 

reductasa (Figura 1). 

 

 

Figura 1. Esquema representativo de la reacción general mediada por los citocromos P450 (CYP). La inserción 

de un átomo de oxígeno al sustrato (RH) requiere un par de electrones provenientes del NADPH. La obtención 

de los electrones es mediada por la NADH-citocromo reductasa (CPR) (2, 5). 
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La superfamilia de CYP se compone de múltiples proteínas que contienen entre 400-500 

residuos de aminoácidos. Están presentes en la mayoría de los organismos, con excepción 

de ciertos grupos bacterianos como Enterobacter spp, Salmonella enterica y Escherichia coli 

(2, 5-7). En mamíferos, los CYP se localizan prácticamente en todo el organismo (10), 

principalmente en los órganos implicados en la biotrasformación tales como hígado, 

intestino y pulmón, donde se encuentran como proteínas transmembranales del retículo 

endoplasmático liso y en la mitocondria (8, 10). 

 

En humanos están identificados 57 CYP, los cuales están organizados en dos grupos: El 

primero se conforma por 35 isoformas involucradas en la biotransformación de 

xenobióticos; y en el segundo se agrupan 22 enzimas encargadas de la biotransformación 

de endobióticos (1, 7). La nomenclatura de esta superfamilia se forma con el prefijo CYP 

seguido de un número que representa a una familia cuando hay una similitud >40% en su 

secuencia de aminoácidos, seguido de una letra, que agrupa a las isoformas con 55% de 

similitud en su secuencia y, por último, un número que representa un gen individual (Figura 

2) (9). 

 

 

Figura 2. Descripción gráfica de la nomenclatura para los CYP. Se utiliza el prefijo CYP seguido de un número 

arábigo que representa a una misma familia con una similitud del 40% en su secuencia de aminoácidos, 

seguido de una letra del alfabeto latino que agrupa a las isoformas con 55% de similitud en su secuencia de 

aminoácidos, por último, un número arábico que representa a la isoforma individual (9). 

 

1. 1 Los CYP1A catalizan endobióticos y xenobióticos 

La subfamilia CYP1A incluye dos genes: CYP1A1 y CYP1A2, ambas isoformas se localizan en 

el cromosoma 15 q24.1 de humano y en 8 q24 de rata, cuyas regiones de DNA tienen una 
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similitud del 70% entre ambas especies. Este porcentaje de similitud está altamente 

conservada entre especies de mamíferos, lo que permite que estas isoformas sean capaces 

de biotransformar tanto endobióticos como xenobióticos con estructuras anilladas (8, 11). 

 

1. 1. 1 Función de CYP1A1 

La función de la isoforma CYP1A1 es muy variada ya que depende del endobiótico que tome 

como sustrato, a partir del cual darán como resultado diversos productos. En el caso de las 

hormonas sexuales, sintetiza progesterona, degrada testosterona y estradiol; en el de otras 

hormonas, degrada melatonina; y en el de vitaminas, produce retinol, entre otros. Por otra 

parte, participa en la biotransformación de xenobióticos (8), entre los que se encuentran los 

hidrocarburos aromáticos policíclicos (PAH), las aminas heterocíclicas y los bifenilos 

policlorados, los cuales están considerados como procarcinógenos, ya que su bioactivación 

se asocia a procesos carcinogénicos (7,9,11,12); así como alrededor del 2% del total de 

fármacos. El CYP1A1 se localiza principalmente en pulmón, intestino, placenta, leucocitos e 

hígado (1, 8). A nivel de mRNA, se ha reportado en páncreas, timo, próstata, intestino 

delgado, útero y glándulas mamarias (8). 

1. 1. 2 Función de CYP1A2 

Las principales funciones y sustratos endobióticos de CYP1A2 comprenden moléculas que 

tienen estructuras heterocíclicas, como las de las hormonas sexuales, donde degrada 

estradiol, sintetiza estriol y pregnenolona; otras hormonas donde degrada melatonina; en 

ácidos grasos donde biotransforma ácido linoleico, sintetiza ácido fosfatídico; y vitaminas 

donde sintetiza retinoides (8, 9, 11). Por otra parte, biotransforman xenobióticos como la 

cafeína, algunos productos industriales como las aminas aromáticas, productos de la 

combustión como las arilaminas heterocíclicas presentes en la comida sobrecosida y cerca 

del 7% de los fármacos como el acetaminofén (9, 13). La presencia de CYP1A2 se reporta en 

prácticamente todo el organismo, pero se expresa fuertemente en hígado, con reportes de 

expresión de mRNA en otros órganos como en colon (8). 
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Tabla 1. Funciones de las isoformas de CYP1A. 

Isoforma Función Sustrato Referencia 

CYP1A1 Hidroxilación y 

oxidación 

Compuestos 

aromáticos, 

hidrocarburos 

aromáticos 

(Lu et al., 2019) 

Hidroxilación  Progesterona, 

pregnenolona y 

estradiol 

(Niwa et al., 1998) 

(Spink et al., 1994) 

CYP1A2 Hidroxilación y 

oxidación 

Aminas aromáticas, 

compuestos 

heterocíclicos 

(Lu et al., 2019) 

Degradación Melatonina (Von Bahr et al. 2000) 

 Ácido linoleico (Moran et al. 2000) 

 Fosfatidilcolina (Yun et al. 1999) 

Hidroxilación y 

Oxidación 

Progesterona, estradiol 

y testosterona 

(T. Niwa et al. 1998) 

(Schwarz et al. 2000) 

 

 

Figura 3. Diagrama de la biotransformación de benzo[a]pireno (A), que es catalizado por CYP1A1 en dos 

ocasiones, primero formando 7,8 epóxido B[a]P, luego es hidrolizado por EOH formando 7,8 dihidrodiol B[a]P, 

finalmente CYP1A1 vuelve a actuar para formar el metabolito genotóxico 7,8 diol 9-10 epóxido de 

benzo[a]pireno, BPDE. En B) aflatoxina B1 es biotransformado por CYP1A2 en 2,3 epóxido aflatoxina B1. EOH 

= epóxido hidrolasa.  
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1. 2 Vía del receptor de hidrocarburo de arilo 

El receptor de hidrocarburos de arilo (AHR) es un factor de transcripción activado por 

ligando que regula la expresión de los CYP1A (9, 13, 14). El AHR se localiza en el citosol en su 

forma inactiva en complejo con la proteína de choque térmico 90 (HSP90), la co-chaperona 

p23 y la proteína 2 asociada al activador transcripcional X, descrito en el virus de hepatitis 

B (XAP2), que en conjunto le proporcionan estabilidad estructural. La activación de AHR por 

unión a un ligando promueve su traslocación al núcleo, donde interactúa con el 

translocador nuclear de AHR (ARNT) provocando la separación de HSP90, p23 y XAP2. El 

heterodímero AHR-ARNT reconoce los elementos de respuesta a xenobióticos (XRE) en el 

DNA promoviendo la transcripción de CYP1A1, CYP1A2 y CYP1B1 (Figura 4) (7, 8, 10, 14, 16). 
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Figura 4. Diagrama de la vía del AHR. La unión de un ligando con AHR produce la formación del complejo de 

AHR con las chaperonas HSP90, XAP2 y p23, esto permite la traslocación al núcleo y la separación de las 

chaperonas, formando el heterodímero AHR-ARNT. En el núcleo, este interactúa con la región promotora XRE 

del DNA para inducir la expresión de genes CYP1A (16). 

 

La inducción de la expresión de genes CYP1A por la vía de AHR se considera como un 

proceso adaptativo donde el organismo responde a ligandos exógenos que estimulan la 

síntesis de proteínas, provocando un aumento en la cantidad de la enzima en el organismo 

para la biotransformación del agente xenobiótico (8).  
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Los ligandos que activan la vía del AHR, se clasifican en dos grupos: clásicos y no clásicos. 

Los ligandos clásicos, llamados así por su alta afinidad de unión a AHR, comprenden 

componentes de contaminantes ambientales con estructuras planas como las aminas 

heterocíclicas, los bifenilos policlorinados, fármacos como el omeprazol (8) y los 

hidrocarburos aromáticos policíclicos, entre los que destaca el benzo[a]pireno (B[a]P) por 

ser un potente inductor de la vía de AHR (Figura 5) (17). Los ligandos no clásicos son 

componentes naturales con menor toxicidad, pero capaces de inducir a AHR (27). El grupo 

más extenso de los ligandos no clásicos es el de los flavonoides que, de acuerdo con algunos 

reportes, el efecto de distintas flavonas hidroxiladas como diosmetina, diosmina, 

quercetina, taxifolina, morina, robinetina, luteolina y apigenina, se unen al AHR e inducen 

la expresión de las enzimas CYP1A (14, 18, 19, 20). De igual forma se ha reportado que otras 

flavonas como galangina, miricetina (28, 29), crisina, apigenina (7, 30, 31) y luteolina (7, 33) inhiben 

la actividad catalítica de CYP1A en diferentes modelos experimentales in silico. 

 

 

Figura 5. Esquema de ligandos clásicos y no clásicos de AHR. (45) 2,3,7,8-tetraclorodibenzo-p-dioxina o TCDD. 
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1. 3 Flavonoides  

Los flavonoides forman la clase más amplia de polifenoles con alrededor de 9 000 

componentes naturales que poseen propiedades diferenciadas y están presentes en todos 

los órganos de las plantas (22-24). En la fisiología vegetal, los flavonoides desempeñan 

diversas funciones, como la de protección de rayos ultravioletas-B (UV-B), pigmentación 

para la atracción de polinizadores, como fitoalexinas, moléculas de señalización celular y 

como reguladores de auxinas (23). La estructura fundamental de los flavonoides está 

compuesta de 15 átomos de carbono dispuestos en tres anillos denominados A, B y C, los 

cuales pueden presentar varios tipos de sustituciones y diferentes niveles de oxidación, 

conformando varias subclases de flavonoides, (Figura 6) (22). En mamíferos, una dieta con 

flavonoides manifiesta en el organismo propiedades antiinflamatorias, antioxidantes y 

anticarcinogénicas, cuyos efectos están determinados por sus características estructurales 

(14, 24, 25). 

 

Figura 6. Estructura fundamental de la flavona con los nombres de los anillos y la posición de sus carbonos. 

(22) 

Las subclases de flavonoides son flavanoles, flavanonas, flavonoles, flavonas, antocianidinas 

e isoflavonas. La variedad y complejidad de estructuras dentro de los flavonoides, así como 

sus efectos en el metabolismo, se debe principalmente al nivel y posición de grupos 

hidroxilo, además de su grado de metilación y glicosilación en su estructura sencilla (Figura 

7) (14, 18, 22, 25).  
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1. 3. 1 Las flavonas y sus propiedades bioquímicas 

La subclase de flavonas está presente en todos los grupos vegetales, con excepción de las 

briofitas hepáticas del género Anthoceros (23). Las flavonas comprenden varias moléculas 

identificadas, como diosmetina, diosmina, quercetina, taxifolina, morina, robinetina, 

luteolina y apigenina (14, 25). Se encuentran comúnmente en vegetales y frutas de la dieta 

diaria como la cebolla, el perejil, la hoja de té, la naranja, el brócoli, el apio, la zanahoria, la 

pimienta, la manzana y la manzanilla, entre otras (22). 

 

 

Figura 7. Esquema representativo de las flavonas más abundantes en las plantas. Se destaca en azul ejemplos 

de los tipos de sustitución y sus posiciones específicas en los carbonos de la estructura básica de la flavona. 

 

Como se ha mencionado, se han reportado los efectos de distintas flavonas con diferentes 

niveles y tipos de sustitución, como diosmetina, diosmina, quercetina, taxifolina, morina, 

robinetina, luteolina y apigenina los cuales se unen al AHR induciendo la expresión de las 

enzimas CYP1A (14, 18, 19, 20). De igual forma se reporta que varias flavonas inhiben la actividad 

catalítica de CYP1A en diferentes modelos experimentales in vitro a través del ensayo de la 

O-desalquilación de la etoxiresorufna (EROD) y metoxiresorufina (MROD) (31), como la 

galangina, miricetina, cuyo efecto se observó en células HepG2 (28, 29); crisina, apigenina 

cuyo efecto se observó en células HepG2 y en células de hámster chino (7, 30, 31) y diosmetina 

donde se observó su efecto en células de L-MDR1 (30, 31)  
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II Planteamiento del problema 

Actualmente, el estudio de diversos metabolitos vegetales y sus efectos en la 

biotransformación de xenobióticos son de creciente interés, debido a que nos permite 

explorar posibles agentes quimioprotectores y candidatos a fármacos que contrarresten la 

bioactivación de carcinógenos asociados a la actividad de los citocromos P450.  

 

Los CYP1A están implicados en procesos de activación de procarcinógenos y en la 

eliminación de endobióticos y xenobióticos del organismo a través de biotransformación (8, 

9). Su expresión está regulada por la vía del AHR, la cual se activa por diversos ligandos (9, 13, 

14). Dentro de los ligandos naturales de AHR, el grupo más extenso es el de los flavonoides, 

y entre estos, las flavonas se identifican por ser los flavonoides menos complejos y por su 

amplia presencia en vegetales (23) y las ingerimos constantemente en nuestra alimentación 

(21). Se ha reportado que múltiples flavonas entre las que se encuentran galangina, 

miricetina (28, 29), crisina, apigenina (30, 31) y luteolina (7, 33), son capaces de activar la vía de 

AHR, induciendo la expresión de CYP1A (14, 18-20), al tiempo inhiben su actividad catalítica de 

acuerdo con diferentes modelos experimentales (7, 28-31, 33). Sin embargo, aún no existe 

suficiente evidencia de que estas propiedades se repliquen por parte de la flavona menos 

compleja, es decir carente de grupos sustituyentes. 

 

Por esta razón, en este trabajo nos propusimos evaluar de forma experimental el efecto de 

la flavona sin sustituyentes sobre la actividad enzimática de CYP1A después de su 

administración en modelo experimental in vivo de Rattus norvegicus. Así también, 

evaluamos in silico a través de estudios de acoplamiento molecular, la posible interacción 

de la flavona con los CYP1A de rata y de la flavona con el AHR de rata. En el presente escrito, 

para mayor claridad, se decidió exponer cada paso experimental como un segmento o 

bloque de investigación, cada uno con su propia hipótesis, objetivos y resultados, partiendo 

desde una hipótesis general.  
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III Hipótesis general 

➢ La actividad total de CYP1A hepático se inhibirá como consecuencia del tratamiento 

con flavona, adicionalmente se observará una atenuación de la actividad total como 

consecuencia del tratamiento combinado de flavona y B[a]P in vivo, y existirá una 

interacción ligando-receptor entre la flavona y las isoformas de CYP1A, así como 

entre la flavona y AHR in silico, en todos los casos usando como modelo 

experimental a Rattus norvegicus. 

IV Objetivo general 

➢ Se evaluarán lo efectos de inhibición de la flavona en las isoformas de CYP1A1 y 1A2 

de forma individual y en tratamiento combinado con B[a]P en modelo in vivo de 

rata, adicionalmente se propondrán las interacciones in silico entre la flavona con 

CYP1A y flavona con AHR a través de acoplamiento molecular. 

V Materiales y métodos 

5. 1 Modelo biológico 

La unidad experimental corresponde a la rata macho cepa Wistar (Rattus norvegicus). Se 

emplearon 16 ratas con un peso aproximado de 196 g provistas por la Unidad de Modelos 

Biológicos del Instituto de Investigaciones Biomédicas de la UNAM. Los animales fueron 

colocados en 4 grupos de 4 individuos cada uno, mantenidos en jaulas de acrílico (40 x 50 x 

20 cm) con acceso a agua y alimento ad libidum a una temperatura de 22 °C con un 

fotoperíodo de 12 h luz- 12 h oscuridad.  

 

5. 2 Tratamientos 

Todos los grupos experimentales recibieron un esquema de administración que consistió 

en 4 dosis de 3 diferentes tratamientos y un control (Figura 8), suministrados en 3 días (1 

dosis por 2 días y 2 dosis en el día tres), en los cuales se usó aceite de maíz como vehículo 

debido a su inocuidad, su facilidad de asimilación por el organismo experimental y porque 
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no interfiere con el efecto de los demás tratamientos (46). El procedimiento se detalla a 

continuación.  

 

 

Figura 8. Esquema que describe los diferentes tratamientos aplicados. Cada grupo se conformó de 4 ratas 

macho con peso promedio de 196 g. 

 

El grupo control (C) recibió 3 dosis de 300 µl de aceite de maíz vía intraperitoneal (ip) (34) 

por tres días. En el tercer día, 1 h después de la última administración, se suministró una 

cuarta dosis de 300 µl de aceite de maíz.  

El segundo grupo (flavona, F), recibió 3 dosis de 80 mg/kg de flavona (Sigma-Aldrich) 

disuelta en aceite de maíz, en un volumen final de 300 µl, vía ip por tres días. En el tercer 

día, 1 h después de la última administración, se suministró una cuarta dosis de 300 µl de 

aceite de maíz. 

El tercer grupo (B[a]P, B) recibió 3 dosis de 300 µl aceite de maíz vía ip por 3 días. En el 

tercer, día 1 h después de la última administración, se suministró una cuarta dosis de 10 

mg/kg de B[a]P (Sigma-Aldrich) disuelto en aceite de maíz en un volumen final de 300 µl. 

El cuarto grupo (Flavona/B[a]P, FB) recibió 80 mg/kg de flavona disueltos en 300 µl de aceite 

de maíz ip por 3 días. Posteriormente, al tercer día 1 h después de la última administración, 

se suministró una cuarta dosis de 10 mg/kg de B[a]P (Sigma-Aldrich) disuelto en aceite de 

maíz en un volumen final de 300 µl.  

En la Tabla 1 se resume el esquema de administración de tratamientos. 
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Todos los animales fueron sacrificados por dislocación cervical 48 h posterior a la última 

administración, tiempo en donde la literatura reporta que en el ciclo biológico de expresión 

de CYP1A se da el punto máximo (34), siguiendo con la reglamentación oficial de la NOM-

062-ZOO-1999 y la aprobación del comité de Bioética del Instituto de Investigaciones 

Biomédicas. Posteriormente se extrajo el hígado y se almacenó a -80 °C hasta su 

procesamiento. 

 

5. 3 Obtención de la fracción microsomal a partir de hígado de rata 

El hígado de cada rata se homogenizó en KCl 0.15 M en una proporción 3:1 peso-volumen, 

se centrifugó a 9 000 x g por 15 min a 4 °C y se recuperó el sobrenadante (fracción S9) (37). 

Se tomaron 6 ml de cada fracción S9, se centrifugaron a 10 000 x g por 1 h a 4 °C. Se descartó 

el sobrenadante y el botón se resuspendió en 6 ml de un amortiguador de fosfatos con 

sacarosa 0.25 M pH 7.4 e inhibidores de proteasas, fosfatasas II y fosfatasas III, donde se 

homogenizó y se centrifugó una vez más bajo las condiciones previas. El nuevo botón se 

resuspendió en 2 ml de amortiguador de fosfatos 1 mM EDTA, 0.1 mM, y glicerol ultrapuro 

al 20% (v/v); se prepararon 20 alícuotas por muestra y se almacenaron a - 80 °C. 
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5. 4 Cuantificación de proteínas totales de la fracción microsomal de hígado de rata 

Se cuantificaron las proteínas de la fracción microsomal conforme al ensayo original de 

Bradford (36) con modificaciones para su lectura en microplaca. Se emplearon 10 µl de una 

dilución 1:80 de la muestra microsomal en agua, agregando 200 µl de una dilución 1:4 del 

reactivo de Bradford en agua, y se determinó la absorbancia a 595 nm en el lector de 

microplaca Synergy H4™. 

 

5. 5 Evaluación de la O-desalquilación de etoxiresorufina (EROD) y metoxiresorufina 

(MROD) por la fracción microsomal de hígado de rata 

La reacción se midió conforme al protocolo original (37) con modificaciones para su lectura 

en microplaca. Se incubó a 37 °C por 3 min un volumen total de 200 µl que contenía los 

siguientes reactivos: 150 µl de amortiguador de Tris 50 mM con MgCl2 24 mM, pH 7.6, luego 

se agregaron 40 µg de proteína de la fracción microsomal, después se añadió 5 µl de EROD 

de una solución a 50 µM. Al final de la incubación, la reacción se inició con la adición de 40 

µl de NADPH 5 mM. Se tomaron 20 lecturas de la fluorescencia en intervalos de 20 s en un 

lector de microplaca Synergy H4™ con excitación de 520 nm y una emisión de 585 nm. En 

el protocolo anterior se reemplazó EROD por MROD del cual se usaron 0.75 µl de una 

solución 500 µM. 

 

5. 6 Estudios de acoplamiento molecular (Molecular docking) 

Las estructuras químicas de flavona (ID: 10230) y α-naftoflavona, α-NF (ID: 11297) se 

obtuvieron de ChemSpider (Royal Society of Chemistry). El formato de ambas estructuras 

se modificó con PyMOL Molecular Graphics System (Shrödinger, LLC versión 2.5.4). Las 

estructuras tridimensionales para CYP1A1, CYP1A2 y AHR se obtuvieron de bases de datos 

especializadas como se muestra en el resumen de tratamientos de la Tabla 2. A cada 

proteína se le removieron iones, moléculas de agua cristalográficas y otros ligandos 

(excepto el grupo hemo) usando PyMOL 2.5.4. La incorporación de cargas atómicas, los 

parámetros de solvatación, así como la simulación del acoplamiento centrado en el sitio 

catalítico de cada proteína se realizó usando AutoDockTools 1.5.6. Los modos de unión 
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mejor obtenidos y las interacciones proteína-ligando fueron visualizadas una vez más con 

PyMOL 2.5.4. Los detalles del procedimiento se encuentran en la sección A-I de los Anexos. 

 

 

 

Para sustentar el acoplamiento molecular, se empleó un modelo por homología para CYP1A 

de rata y AHR de humano/rata, por lo que se obtuvo el porcentaje de similitud de 

aminoácidos entre las isoformas de humano y rata para las proteínas. Se compararon las 

respectivas secuencias de las proteínas experimentales, usando Basic Local Alignment 

Search Tool (BLAST) en la plataforma de NCBI, como se resume en la Tabla 3.  
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5. 7 Análisis estadístico 

Se usó el programa especializado R Studio y GraphPad Prism 8 para el análisis estadístico y 

la obtención de gráficos, en la sección A-II de los Anexos se encuentran los datos obtenidos. 

Por cada grupo de datos, primero se evaluó la normalidad aplicando una prueba de Shapiro-

Wilks con los valores obtenidos de la actividad total (CYP1A1: W = 0.89623, p-value = 

0.06997; CYP1A2: W = 0.94008, p-value = 0.35). Se probó la homocedasticidad aplicando 

una prueba de Levene (CYP1A1: F value = 4.3602, Pr(>F) = 0.02699; CYP1A2: F value = 0.906, 

Pr(>F) = 0.4669). Posteriormente se realizaron pruebas T student con correcciones de Welch 

entre los grupos Control-Flavona y entre B[a]P-Flavona/B[a]P. 

 

VI Experimento A 

6. 1 Hipótesis  

o Considerando el efecto de inhibición de los distintos tipos de flavonas sobre la 

actividad total de CYP1A descrito en la literatura, se espera que la aplicación de un 

tratamiento con la flavona sencilla también inhibirá la actividad total de CYP1A 

hepático en el modelo in vivo de Rattus norvegicus. 

 

6. 2 Objetivos 

• Evaluar el efecto de la flavona en la inhibición de CYP1A1 en microsomas hepáticos 

de rata. 

• Evaluar el efecto de la flavona en la inhibición de CYP1A2 en microsomas hepáticos 

de rata. 

6. 3 Resultados 

Para investigar el efecto de la flavona sobre la actividad catalítica de CYP1A en el hígado de 

rata, se compararon dos tratamientos; un grupo experimental con 80 mg/kg de flavona con 

respecto al grupo Control.  
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6. 3. 1 Reacción de O-desalquilación de la etoxirresorufina con CYP1A1 por flavona 

La actividad enzimática de CYP1A1 se analizó a través del cambio de la etoxirresorufina a 

resorufina (Figura 9A). En la Figura 9 se presentan los resultados de la actividad de CYP1A1. 

El grupo control mostró un valor basal de actividad de 10  4.643396 pmol de resorufina 

por mg por min-1 para esta isoforma. El grupo de flavona (50  4.643396 pmol de resorufina 

por mg por min-1) mostró un aumento significativo (p≤0.05) en la tasa de formación de 

resorufina, de aproximadamente 4 veces, respecto al grupo control.  

 

6. 3. 2 Reacción de O-desalquilación de la metoxirresorufina con CYP1A2 por flavona 

La actividad enzimática de CYP1A2 se avaluó a través del cambio de la metoxiresorufina a 

resorufina con la reacción de la O-desalquilación (Figura 9C). En la Figura 9C se presentan 

los resultados de la actividad de CYP1A2. En el grupo control se observó un valor basal de 

actividad de 5  1.766686 pmol de resorufina por mg por min-1 para esta isoforma. En el 

grupo flavona (9  1.658164 pmol de resorufina por mg por min-1) se observó cerca el doble 

de producción de resorufina respecto al control, siendo un incremento significativo 

(p≤0.05).  
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Figura 9. A) Esquema de la reacción de la O-desalquilación de la metoxirresorufina a resorufina por CYP1A2 

en microsomas de hígado de rata. B) Efecto del tratamiento con flavona (80 mg/kg) en la O-desalquilación de 

la etoxirresorufina por CYP1A1 y C) Efecto del tratamiento con flavona (80 mg/kg) en la O-desalquilación de 

la metoxirresorufina por CYP1A2. Cada barra corresponde al promedio de 3 lecturas de 4 ratas ± E.E. α P ≤ 

0.05 respecto al control. α = diferente vs Control. 
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6. 4 Conclusión 

• El tratamiento con flavona aumenta la actividad total de CYP1A en modelo in vivo 

en microsomas de hígado en R. norvegicus, probablemente al inducir la expresión 

de CYP1A a través de AHR. 

 

VII Experimento B 

7. 1 Hipótesis 

A consecuencia de los resultados de inducción de la actividad por parte de la flavona aunado 

a un posible efecto antagónico entre inducción de la trascripción e inhibición de la actividad 

total, se espera que al aplicar un tratamiento de B[a]P como inductor, así como un 

tratamiento combinado de flavona con B[a]P se observará una atenuación de la inducción 

enfocado en la actividad total de CYP1A hepático en un modelo in vivo de R. norvegicus.  

 

7. 2 Objetivo 

• Evaluar el efecto de la flavona en combinación con el B[a]P, sobre la inducción 

de la actividad total de CYP1A. 

 

7. 3 Resultados 

Para investigar el efecto de inducción observado de la flavona sobre la actividad total de 

CYP1A en microsomas de hígado de rata, se compararon dos tratamientos. Uno de 

inducción, al que se le administró 10 mg/kg de B[a]P y un grupo combinado con flavona más 

B[a]P, lo cual nos permitió obtener más información al observar el efecto dual de la flavona, 

tanto como inhibidor postraduccional como inductor transcripcional de CYP1A. Para ello se 

evaluó el efecto de la flavona en conjunto con dicho inductor conocido de CYP1A. 

 

7. 3. 1 Reacción de O-desalquilación de la etoxirresorufina con CYP1A1 por flavona/B[a]P 

La actividad enzimática de CYP1A1 se analizó a través del cambio de la etoxirresorufina a 

resorufina (Figura 10B). En la Figura 10B se presentan los resultados de la actividad de 
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CYP1A1.  En el tratamiento con B[a]P (150 pMol de resorufina por mg por min-1) se observó 

un aumento en la resorufina de 0.3 veces más en comparación con el grupo combinado de 

Flavona/B[a]P (C) (p≤0.05).   

 

7. 3. 2 Reacción de O-desalquilación de la metoxirresorufina con CYP1A2 por flavona/B[a]P 

La actividad enzimática de CYP1A2 fue analizada a través del cambio de la metoxirresorufina 

a resorufina. En la Figura 10C se presentan los resultados de la actividad de CYP1A1.  En la 

comparación entre los grupos B[a]P y el tratamiento combinado Flavona/B[a]P se 

observaron valores estadísticamente similares de resorufina (p≤0.05), mostrando un nivel 

ligeramente mayor del grupo combinado sobre el tratamiento con B[a]P. 
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Figura 10. A) Esquema de la reacción de la O-desalquilación de la etoxirresorufina a resorufina por CYP1A1 en 

microsomas de hígado de rata. El efecto de B[a]P (10 mg/kg) y la combinación de flavona/B[a]P, en B) la O-

desalquilación de la etoxirresorufina por CYP1A1; y en C) la O-desalquilación de la metoxirresorufina por 

CYP1A2. Cada barra corresponde al promedio de 3 lecturas de 4 ratas ± E.E. α P ≤ 0.05 respecto al control. α 

= diferente vs Control. 
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7. 4 Conclusión 

• El tratamiento con flavona en combinación con B[a]P atenuó la actividad total de 

CYP1A en el modelo in vivo de R. norvegicus. 

• Se observa una tendencia de inducción de CYP1A1 de la flavona menor al de B[a]P.   

VIII Experimento C 

8. 1 Hipótesis 

o Considerando que las flavonas sustituidas activan la expresión de CYP1A a través de 

AHR, asimismo que son ligandos de CYP1A, se espera que la flavona se acoplará 

tanto a CYP1A como a AHR en modelo in silico de R. norvegicus. 

 

8. 2 Objetivo 

• Proponer, mediante estudios de acoplamiento molecular, los modos de 

interacción entre: 

 La flavona y el AHR de rata. 

 La flavona y las isoformas de CYP1A de rata. 

 

8. 3 Resultados 

Se evaluaron las interacciones entre la flavona y las isoformas de CYP1A de las especies 

humano y rata, junto con la interacción flavona con AHR, para que, de acuerdo con los 

resultados obtenidos, proponer la factibilidad de dichas interacciones. Se realizaron 

estudios de acoplamiento molecular siguiendo varias pruebas. Primero, entre la flavona con 

las isoformas de CYP1A y AHR humano (Anexo III) y luego, con sus homólogos de rata. Por 

simplicidad, los resultados del acoplamiento se muestran con solamente los aminoácidos 

de interacción con el ligando (Figuras 11 a 13). 

 

8. 3. 1 Estudios de acoplamiento molecular 

En el acoplamiento entre CYP1A1 de rata con flavona se observó la unión del ligando en el 

sitio catalítico junto al grupo hemo (Figura 11). Esta unión se logra a través de la interacción 
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hidrofóbica (IH) con 5 residuos de aminoácidos (Thr-126, Phe-228, -262, -323, Ala-321), cada 

uno con una IH, excepto Phe262 que presenta dos. También se observó que en los residuos 

Phe 228 y 127 presentan apilamiento de anillos aromáticos, el primero con los anillos A y C, 

mientras que el segundo con el anillo B de la flavona. La estructura planar de la flavona 

presenta una leve rotación en su enlace C2-C1’, cuya conformación presenta la estructura 

energética más favorable de -12.20 kcal/mol. 

 

 

Figura 11. Acoplamiento entre CYP1A1 de rata con flavona. Rosa: grupo hemo; azul cian: flavona; verde: 

aminoácidos de interacción; líneas negras punteadas: interacción hidrofóbica; líneas rojas punteadas: 

apilamiento de anillos aromáticos. 

 

La Figura 12 muestra los resultados del acoplamiento entre CYP1A2 de rata con flavona. Se 

observó la unión del ligando en el sitio catalítico junto al grupo hemo. La unión se logra a 

través de la IH con 8 residuos de aminoácidos (Ile-384, Thr-123, Leu-495, Phe-124, 225, 255, 

259 y Ala-315), entre los que destacan Phe 255 y 259, ambos con dos IH con el anillo B de 

la flavona; mientras que con Phe-225 se observó una IH con el anillo C y un apilamiento de 

anillo aromático con el anillo B de la flavona. La estructura de la flavona conserva su forma 

planar, sin rotación en el enlace C2-C1’, adoptando la conformación energéticamente más 

favorable de -12.10 kcal/mol. 
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Figura 12. Acoplamiento entre CYP1A2 rata con flavona. Rosa: grupo hemo; azul cian: flavona; verde: 

aminoácidos de interacción; líneas negras punteadas: interacción hidrofóbica; líneas rojas punteadas: 

apilamiento de anillos aromáticos. 

 

En la figura 13 se muestra el acoplamiento entre AHR de rata con flavona donde se 

observaron IH de 7 residuos de aminoácidos (Ile-152, Ala-78, Phe-55, 82, Tyr-75, 135, 122 y 

Pro-54) con la flavona cuyo enlace C2-C1’ que conecta con el anillo B presenta una torsión 

oblicua respecto al resto de la molécula, formando una unión de -8.00 kcal/mol con AHR. 

 

Figura 13. Acoplamiento entre AHR de rata con flavona. Azul cian: flavona; verde: aminoácidos de interacción; 

línea punteada: interacciones hidrofóbicas. 
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IX Discusión 

Las flavonas son metabolitos presentes en una gran diversidad de vegetales con 

propiedades antiinflamatorias, antioxidantes y anticarcinogénicas (14, 22, 24, 25). Se ha 

reportado que poseen la capacidad de modular la biotransformación de xenobióticos (25). 

La familia CYP1A biotransforma este tipo de metabolitos que, por su participación en la 

formación de carcinógenos, así como en la inducción de resistencia a fármacos por la 

inactivación de agentes quimioterapéuticos es que han atraído el interés en diversos 

estudios (9, 13). Los sustratos de los CYP1A son ligandos del AHR que al activarse tiene efectos 

diversos, como la de iniciar un proceso de activación de procarcinógenos que inducen la 

expresión de CYP1A y, en consecuencia, propiciar el desarrollo de cáncer en tejidos 

específicos (8, 13). El B[a]P es un PAH con efectos carcinogénicos y un potente inductor 

transcripcional de CYP1A. Se forma por la combustión parcial de materia orgánica, como en 

alimentos cocinados en exceso y está presente en el escape de vehículos y en el humo de 

cigarro. En este trabajo se evaluó la inhibición de la actividad total de CYP1A1 y CYP1A2 en 

microsomas hepáticos de R. norvegicus después de un tratamiento con flavona y se 

comparó con B[a]P y cotratamientos de ambos. Los datos obtenidos de la reacción de O-

desalquilación de la metoxirresorufina y la etoxirresorufina mostraron cambios notables en 

la actividad global de CYP1A, que coinciden con lo reportado en estudios previos.  

 

Los grupos experimentales recibieron durante los tres días de tratamiento aceite de maíz 

como vehículo debido a su inocuidad, su facilidad de asimilación por el organismo 

experimental y porque no interfiere con el efecto de los demás tratamientos (46). En el grupo 

control se aplicaron únicamente dosis de aceite de maíz, obteniendo un valor basal de 

actividad de 10 pmol de resorufina por mg por min-1 para la isoforma CYP1A1 y de 5 pmol 

de resorufina por mg por min-1 para la isoforma CYP1A2, mostrando que ambas enzimas se 

expresan de forma constitutiva en condiciones fisiológicas controladas. El resultado fue 

diferente en el grupo tratado con flavona disuelta en aceite de maíz, donde se observó a 

través de la reacción de EROD y MROD, un aumento en la formación de resorufina para 

ambas isoformas de CYP1A. Lo anterior se puede interpretar como un incremento de 
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aproximadamente 5 veces en CYP1A1 y de casi el doble en CYP1A2 en comparación con el 

Control, posiblemente como consecuencia de un incremento en la inducción transcripcional 

de CYP1A por parte de la flavona. Estos resultados sugieren la posibilidad de que la flavona 

sea un ligando de AHR de rata que induce la expresión de CYP1A, aumentando la cantidad 

de enzima funcional en el grupo tratado, lo que correspondería con el incremento de la 

resorufina a partir de la reacción de la O-desalquilación de la etoxirresorufina o de la 

metoxirresorufina catalizada por CYP1A1 y CYP1A2, respectivamente. Lo anterior encuentra 

soporte en los resultados de acoplamiento molecular entre la flavona y el AHR de rata, 

donde se obtuvieron energías de afinidad de -8.00 kcal/mol que, de acuerdo con la ecuación 

de la energía libre de Gibbs, ∆G = ∆H – T∆S para condiciones de temperatura, presión y de 

sistemas biológicos constantes, donde los valores más negativos son más favorables para 

que ocurra la reacción. También es posible que la flavona se una a CYP1A y bloquee el sitio 

catalítico, inhibiendo parcialmente su función en la formación de resorufina en la O-

desalquilación de la etoxirresorufina. Los resultados del acoplamiento muestran que la 

energía de afinidad entre flavona y CYP1A1 de rata fue de -12.20 kcal/mol, semejante a lo 

obtenido en otros estudios de acoplamiento entre flavona con CYP1A1 de humano (48). Dado 

que esta energía de afinidad es mayor a la obtenida entre flavona y AHR, la posible 

inhibición de CYP1A sería más factible. Sin embargo, los resultados corresponden a un 

aumento de la actividad total de CYP1A, probablemente la localización diferencial de las 

proteínas implicadas sea un factor a favor de que estos resultados se inclinaran hacia la 

inducción transcripcional sobre la actividad enzimática, ya que AHR se encuentra en el 

citosol, mientras que los CYP1A se encuentran como proteínas transmembranales de 

retículo endoplasmático liso. No obstante, y en contraste con los resultados, se ha 

reportado que otras flavonas, como galangina, miricetina (28, 29) crisina, apigenina, (7, 30, 31) y 

luteolina (7, 33), inhiben la actividad catalítica de CYP1A en diferentes modelos 

experimentales in silico, probablemente a causa de las diferencias estructurales de grupos 

sustituyentes, como hidroxilación y metilación, particulares de cada tipo de flavona. Por lo 

tanto, contrario a lo esperado en nuestra hipótesis, en los resultados experimentales se 
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observó un incremento, en vez de una inhibición, de la actividad global de CYP1A en 

microsomas de hígado de rata después de un tratamiento con flavona. 

 

Al observar el aumento de la actividad total de CYP1A como resultado del tratamiento con 

flavona, se evaluó qué tan potente sería el efecto inductor de este flavonoide al compararlo 

con un tratamiento con B[a]P. En el grupo tratado con una dosis única de B[a]P disuelto en 

aceite de maíz se observó un aumento en la formación de resorufina, catalizada por 

CYP1A1, que corresponde a una inducción de la actividad de aproximadamente 14 veces en 

comparación con la observada en el grupo Control, como era de esperarse como control 

positivo, así como un aumento de la resorufina de 0.6 veces, en comparación con el grupo 

combinado Flavona/B[a]P. Sin embargo, es posible que la inducción observada de CYP1A 

por B[a]P, así como el potencial inductor de B[a]P en general, se haya debido a una 

inducción estimulada por alguno de sus metabolitos hidroxilados como 3-hidroxi-

benzo[a]pireno (3-OH-B[a]P), 7-hidroxi-benzo[a]pireno (7-OH-B[a]P), 9-hidroxi-

benzo[a]pireno (9-OH-B[a]P); o metabolitos glucorinados como B[a]P 3-O-G, B[a]P 7-O-G, 

B[a]P 9-O-G), ya que se ha reportado que estos metabolitos formados también inducen la 

transcripción de CYP1A a través de AHR en línea celular del epitelio oral humano, 

probablemente causando un segundo ciclo de inducción transcripcional, semejante a un 

efecto de retroalimentación positiva (51).  

 

Con respecto al efecto sobre CYP1A2 en la reacción de la O-deaslquilación de la 

metoxirresorufina, se observó un aumento de poco más del doble en comparación con el 

Control, menor a lo observado con CYP1A1. Es posible fundamentar lo anterior porque 

CYP1A1 es la principal isoforma que biotransforma al B[a]P en sus metabolitos hidroxilados, 

como el benzo[a]piyrene diol epoxide (BPDE) (9). En su defecto, dicha variación puede ser 

atribuible a diferencias interindividuales en los organismos experimentales, o bien, por 

alteración fisiológica del organismo a causa de estrés, ya que se ha reportado que la 

administración intraperitoneal podría tener efectos de irritación por las inyecciones, o por 
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la aplicación de volúmenes de sustancia demasiado grandes, con relación con el peso 

individual del organismo, que suelen distender el abdomen y provocar malestar (49).  

 

En lo referente al tratamiento combinado con flavona y una dosis de B[a]P, se observó un 

aumento de la resorufina, catalizada por CYP1A1, que corresponde a un incremento de 

aproximadamente 10 veces más a lo obtenido en el Control. Sin embargo, si comparamos 

este aumento con lo observado en el tratamiento con flavona, así como en el tratamiento 

con B[a]P, se podría esperar un efecto sinérgico en el grupo combinado Flavona/B[a]P, dado 

que ambos sustratos indujeron la actividad de CYP1A1. Diferente a lo esperado, se observó 

un valor intermedio entre los niveles de resorufina formada entre los grupos de Flavona y 

en el grupo de B[a]P. Una vez más, esta hipótesis se sostiene si comparamos las energías de 

afinidad obtenidas por las pruebas de acoplamiento con AHR, donde se muestra que puede 

haber unión entre flavona y AHR de humano y entre flavona y AHR de rata con energías de 

afinidad de -8.10 y -8.00 Kcal/mol, respectivamente; y que presentarían una afinidad 

ligeramente menor a la obtenida en el acoplamiento entre B[a]P y AHR de -8.60 kcal/mol, 

lo que sugiere que en efecto la flavona se une a AHR y que posiblemente exista inhibición 

competitiva con B[a]P por el receptor. Conociendo que el B[a]P induce la expresión del 

mRNA de CYP1A al activar la vía de AHR (7, 9, 14, 16), en este mismo sentido, existen reportes 

de otras flavonas, como apigenina, baicalenina, chrysina, diosmetina, daidzeina, galangina, 

genisteína y quercitina, que incrementan la transcripción de CYP1A a través de la activación 

de AHR (31). Aunado a lo anterior, y en conjunto con los resultados de actividad que se 

reportan, se señala la posibilidad de que la flavona menos compleja, sin grupos 

sustituyentes, se acople al AHR e induzca la vía de expresión del mRNA de CYP1A y, en 

consecuencia, aumente la cantidad de enzima en microsomas de hígado de rata, e inclusive 

podría fomentar la biotransformación de otros xenobióticos. Dicho aumento en la 

concentración también podría haberse reflejado en los ensayos de EROD y MROD, ya que, 

al existir mayor cantidad de enzima, habría mayor cantidad de resorufina, y en consecuencia 

actividad total de CYP1A. Por otra parte, en lo que refiere a la unión entre flavona y CYP1A, 

los resultados del acoplamiento mostraron que la energía de afinidad entre flavona y 
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CYP1A1 de rata fue de -12.20 kcal/mol, que en comparación con la energía de -15.7 kcal/mol 

entre B[a]P y CYP1A1 de rata, señalando que este efecto interesante puede atribuirse a una 

inhibición competitiva entre estas dos sustancias por el sitio catalítico de CYP1A1 dentro de 

los organismos experimentales, durante el tiempo de inducción a lo largo del día 4, que 

probablemente haya sucedido en favor del B[a]P debido a su mayor afinidad por la enzima. 

Respecto a lo obtenido con la isoforma CYP1A2 en el grupo Flavona/B[a]P, se observó un 

aumento de resorufina producida por CYP1A2, que corresponde a una inducción en su 

actividad de casi el triple respecto al Control. No obstante, no parece observarse un efecto 

de inhibición competitiva de la enzima por los sustratos, como en el caso de CYP1A1; 

además de que el nivel de resorufina es semejante al del grupo tratado únicamente con 

B[a]P. Estos resultados pueden deberse a la inducción inesperadamente baja en el grupo 

de B[a]P en esta isoforma que, como se ha discutido, no manifestó su verdadero poder 

catalítico, o bien, por una inducción diferencial de la flavona para cada isoforma. Esto último 

es probable si tomamos en cuenta que se ha reportado que existen clusters de CYP: CPR en 

una proporción 20:1 en microsomas de hígado de rata (52), lo que sugiere la existencia de 

una dinámica de reacciones limitadas en función de la presencia o ausencia de CPR 

disponibles. Aunado a lo anterior, es posible la presencia de diferentes isoformas en estos 

clusters, que varian en cantidad dependiendo del tejido u organismo, como es el caso del 

CYP1A2, que solo se encuentra mayormente en tejido hepático (8), lo que podría ser la causa 

de los niveles diferenciados de resorufina en los grupos experimentales. Adicionalmente, 

existe la posibilidad de que la activación de AHR por flavona induzca vías de señalización 

alternas como la actividad de miembros de NF-kB, receptores de estrógeno, funciones de 

respuesta inmune, células troncales, cáncer, entre otros (39). Así como procesos celulares 

como migración y diferenciación (47, 48, 50).  
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X Conclusiones 

• El tratamiento con flavona provocó un incremento en la actividad total de CYP1A 

en el modelo in vivo en microsomas de hígado en R. norvegicus, lo cual 

posiblemente se debe a la inducción de la expresión de CYP1A a través de AHR. 

• El tratamiento con flavona provocó una disminución en la actividad total de CYP1A 

cuando se administró en combinación con B[a]P en el modelo in vivo de R. 

norvegicus. 

• Se observa una tendencia de inducción de CYP1A1 de la flavona menor al de B[a]P.   

• A partir de los estudios de acoplamiento molecular, se propone que la flavona es 

un ligando de las enzimas CYP1A de R. norvegicus. 

• A partir de los estudios de acoplamiento molecular, se propone que la flavona es 

ligando del AHR de R. norvegicus e induce la transcripción de CYP1A. 

XI Perspectivas 

• Evaluar la toxicidad de la flavona con diversas concentraciones en modelo de R. 

norvegicus. 

• Evaluar la cantidad de mRNA de CYP1A después de la administración de flavona en 

R. norvegicus. 

• Evaluar los efectos de la flavona en la actividad catalítica de CYP1B1 de R. norvegicus. 

• Evaluar el efecto de la flavona en la actividad y la toxicidad en otros tejidos 

relacionado con la biotransformación de xenobióticos, como pulmón e intestino. 

• Evaluar los efectos de la flavona en procesos celulares de diferenciación celular al 

activar al AHR en modelo in vivo. 
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XIII Anexos 

A-I Estudios de acoplamiento molecular. 

Programas utilizados para realizar el acoplamiento molecular. 

1) PyMOL: Permite visualizar las estructuras tridimensionales de las macromoléculas. 

• Descargar en  https://pymol.org/2/ 

• Tramitar licencia de uso educativo en https://pymol.org/edu/?q=educational/ 

2) Vina de AutoDock Tools 1.5.6.  

• Descargar en https://vina.scripps.edu/downloads/ 

 
Tabla A1. Procedimiento para realizar una prueba de acoplamiento molecular. 
Paso 1. Obtención de la estructura tridimensional 
de las proteínas de interés. 

Paso 2. Obtención de la estructura tridimensional 
de los ligandos (compuestos a evaluar). 

-Ingresar al Protein Data Bank (PDB) en 
https://www.rcsb.org/ 
-Realizar la búsqueda de la proteína de interés. 
-Dar click en el número de identificación de la 
proteína. 
-Click en Download files -> guardar como PDB 
Format. 
 

-Ingresar a ChemSpider en:  
http://www.chemspider.com/ 
-Realizar la búsqueda de los compuestos de interés. 
-Click en el número de identificación del compuesto. 
-Click en ícono para guardar la estructura como 
formato (.mol) 
 

Paso 3. Convertir archivos de mol a mol2 para 
ligandos. 

Paso 4. Generar archivos pdbqt para ligandos. 

-Abrir el programa PyMOL. 
-Skip activation  
-File -> Open -> Escoger archivo mol 
-File -> Export molecule -> Save 
-Nombrar con formato (.mol2) 
-Guardar en carpeta de estructuras. 
 

-Abrir AutoDock Tools. 
-Ligand -> Input -> Open -> Selec archivo mol2 
-Ligand -> Torsion tree -> Detect root 
-Ligand -> Output -> Save as PDBQT 
Guardar en formato (.pdbqt) en carpeta de 
estructuras. 
 

Paso 5. Modificar pdb. Paso 6. Generar archivos pdbqt para proteínas. 

-Abrir PyMOL. 
-Skip activation 
-File -> Open -> Escoger archivo pdb 
-Display -> Secuence 
-Seleccionar con el cursor 00000, ligandos NO HEM, 
otras cadenas. 
-Click derecho -> Remove 
-File -> Export molecule -> Save 
-Nombrar con formato (.pdb) 
-Guardar en carpeta de estructuras. 
 

-Abrir AutoDock tools. 
-Grid -> Macromolecule -> Open -> Selec pdb de 
proteína 
-Guardar con formato (.pdbqt) en carpeta de 
estructuras. 
-Grid -> Grid box 
-Anotar valores de x center, y center, z center 
Cerrar 
 
 

Paso 7. Docking. Paso 8. Inspeccionar en PyMOL los modos de unión. 

-Abrir símbolo del sistema 
-Ubicarse en la carpeta de estructuras. 

-File -> Open -> Seleccionar ligand_out.pdbqt 
-File -> Open -> Seleccionar archivo pdb de la 
proteína 

https://pymol.org/2/
https://pymol.org/edu/?q=educational/
https://vina.scripps.edu/downloads/
https://www.rcsb.org/
http://www.chemspider.com/
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-Usar los comandos: .\vina.exe --center_x -19.52 --
center_y 24.003 --center_z 13.086 --size_x 44 --
size_y 44 --size_z 44 --ligand Dcatequina.pdbqt --
receptor CYP3A4.pdbqt 
-Anotar en excel los valores de afinidad para los 3 
primeros modos de unión. 
-El programa generará un archivo ligand_out.pdbqt 
en la carpeta de estructuras. 
 

-Con las flechas del teclado observar los modos de 
unión. 
 
 
 

Paso 9.  Análisis de resultados en AutoDock tolos. Paso 10. Análisis de resultados en AutoDock tools y 
Maestro. 

-Abrir AutoDock Tools. 
-Analyze -> Docking -> Open AutoDock vina result  
-> Seleccionar ligando_out.pdbqt 
-Load models as a single molecule with multiple 
conformations -> OK 
-Analyze -> Macromolecule -> Open -> Seleccionar 
receptor.pdbqt 
-Seleccionar R y quitar L 
-Analyze -> Dockings -> Show Interactions 
-Marcar puentes de hidrógeno 
-Anotar aminoácidos de interacción. 

-Abrir Maestro 
-File -> Import structures -> Seleccionar archivo 
pdb de Autodock tools -> Import -> Ok 
-Edit -> 2D Sketcher 
-Añadir enlaces con la opción Draw -> Update entry 
File -> Import Structures -> Seleccionar archivo pdb 
de la proteína -> Import -> Ok 
-Posicionarse en el círculo azul del Entry List, junto 
al nombre de la proteína -> click derecho -> Fix in 
Workspace -> Dar click en el círculo del Entry List,  
-Seleccionar Ligand Interaction  
-Se abre 2D Workspace Ligand Interaction Diagram 
-Verificar que la estructura del ligando sea correcta 
-File, Save screenshot. 
 

 
 

A-II Datos estadísticos. 

Tabla A2. Datos obtenidos de actividad específica de CYP1A1 (pmol/mg proteína * min). * 

Control Flavona B[a]P Flavona-B[a]P 

12.3577 ± 0.216 
 

43.0450 ± 3.330 69.7234 ± 4.348 91.8861 ± 5.628 

17.2076 ± 1.171 
 

49.8433 ± 1.619 214.1458 ± 1.675 153.7365 ± 8.739 

10.5792 ± 0.986 
 

65.2434 ± 2.790 191.7269 ± 4.509 73.5860 ± 7.044 

5.9749 ± 0.409 
 

43.3475 ± 1.558 181.8710 ± 10.371 117.5180 ± 4.598 

 
Tabla A3. Datos obtenidos de actividad específica de CYP1A2 (pmol/mg proteína * min). * 

Control Flavona B[a]P Flavona-B[a]P 

6.0968 ± 0.624  
 

10.0354 ± 0.462 7.8867 ± 0.745 12.7645 ± 0.917 

7.2450 ± 0.287 
 

8.5024 ± 0.463 13.8315 ± 1.178 12.2302 ± 0.774 

3.9462 ± 0.435 

 
10.9253 ± 0.564 13.0441 ± 2.593 10.9722 ± 0.719 

3.5251 ± 0.490 
 

7.1767 ± 0.505 13.7904 ± 1.181 14.6529 ± 0.368 



44 
 

 
*Cada valor corresponde al promedio de 3 lecturas de 4 ratas ± E.E. α P ≤ 0.05 respecto al control. 

 

A-III Secuencia de aminoácidos para las isoformas de CYP1A 

Tabla A4. Secuencia de aminoácidos para las isoformas de CYP1A 

CYP1A1 humano 
MLFPISMSATEFLLASVIFCLVFWVIRASRPQVPKGLKNPPGPWGWPLIGHMLTLGKNPHLALSRMSQQYG

DVLQIRIGSTPVVVLSGLDTIRQALVRQGDDFKGRPDLYTFTLISNGQSMSFSPDSGPVWAARRRLAQNGL

KSFSIASDPASSTSCYLEEHVSKEAEVLISTLQELMAGPGHFNPYRYVVVSVTNVICAICFGRRYDHNHQE

LLSLVNLNNNFGEVVGSGNPADFIPILRYLPNPSLNAFKDLNEKFYSFMQKMVKEHYKTFEKGHIRDITDS

LIEHCQEKQLDENANVQLSDEKIINIVLDLFGAGFDTVTTAISWSLMYLVMNPRVQRKIQEELDTVIGRSR

RPRLSDRSHLPYMEAFILETFRHSSFVPFTIPHSTTRDTSLKGFYIPKGRCVFVNQWQINHDQKLWVNPSE

FLPERFLTPDGAIDKVLSEKVIIFGMGKRKCIGETIARWEVFLFLAILLQRVEFSVPLGVKVDMTPIYGLT

MKHACCEHFQMQLRS 

 

CYP1A1 rata 
MPSVYGFPAFTSATELLLAVTTFCLGFWVVRVTRTWVPKGLKSPPGPWGLPFIGHVLTLGKNPHLSLTKL 

SQQYGDVLQIRIGSTPVVVLSGLNTIKQALVKQGDDFKGRPDLYSFTLIANGQSMTFNPDSGPLWAARRR 

LAQNALKSFSIASDPTLASSCYLEEHVSKEAEYLISKFQKLMAEVGHFDPFKYLVVSVANVICAICFGRR 

YDHDDQELLSIVNLSNEFGEVTGSGYPADFIPILRYLPNSSLDAFKDLNKKFYSFMKKLIKEHYRTFEKG 

HIRDITDSLIEHCQDRRLDENANVQLSDDKVITIVFDLFGAGFDTITTAISWSLMYLVTNPRIQRKIQEE 

LDTVIGRDRQPRLSDRPQLPYLEAFILETFRHSSFVPFTIPHSTIRDTSLNGFYIPKGHCVFVNQWQVNH 

DQELWGDPNEFRPERFLTSSGTLDKHLSEKVILFGLGKRKCIGETIGRLEVFLFLAILLQQMEFNVSPGE 

KVDMTPAYGLTLKHARCEHFQVQMRSSGPQHLQA 

 
CYP1A2 humano 
MALSQSVPFSATELLLASAIFCLVFWVLKGLRPRVPKGLKSPPEPWGWPLLGHVLTLGKNPHLALSRMSQ 

RYGDVLQIRIGSTPVLVLSRLDTIRQALVRQGDDFKGRPDLYTSTLITDGQSLTFSTDSGPVWAARRRLA 

QNALNTFSIASDPASSSSCYLEEHVSKEAKALISRLQELMAGPGHFDPYNQVVVSVANVIGAMCFGQHFP 

ESSDEMLSLVKNTHEFVETASSGNPLDFFPILRYLPNPALQRFKAFNQRFLWFLQKTVQEHYQDFDKNSV 

RDITGALFKHSKKGPRASGNLIPQEKIVNLVNDIFGAGFDTVTTAISWSLMYLVTKPEIQRKIQKELDTV 

IGRERRPRLSDRPQLPYLEAFILETFRHSSFLPFTIPHSTTRDTTLNGFYIPKKCCVFVNQWQVNHDPEL 

WEDPSEFRPERFLTADGTAINKPLSEKMMLFGMGKRRCIGEVLAKWEIFLFLAILLQQLEFSVPPGVKVD 

LTPIYGLTMKHARCEHVQARLRFSIN 

 
CYP1A2 rata 
MAFSQYISLAPELLLATAIFCLVFWVLRGTRTQVPKGLKSPPGPWGLPFIGHMLTLGKNPHLSLTKLSQQ 

YGDVLQIRIGSTPVVVLSGLNTIKQALVKQGDDFKGRPDLYSFTLITNGKSMTFNPDSGPVWAARRRLAQ 

DALKSFSIASDPTSVSSCYLEEHVSKEANHLISKFQKLMAEVGHFEPVNQVVESVANVIGAMCFGKNFPR 

KSEEMLNLVKSSKDFVENVTSGNAVDFFPVLRYLPNPALKRFKNFNDNFVLFLQKTVQEHYQDFNKNSIQ 

DITGALFKHSENYKDNGGLIPQEKIVNIVNDIFGAGFETVTTAIFWSILLLVTEPKVQRKIHEELDTVIG 

RDRQPRLSDRPQLPYLEAFILEIYRYTSFVPFTIPHSTTRDTSLNGFHIPKECCIFINQWQVNHDEKQWK 

DPFVFRPERFLTNDNTAIDKTLSEKVMLFGLGKRRCIGEIPAKWEVFLFLAILLHQLEFTVPPGVKVDLT 

PSYGLTMKPRTCEHVQAWPRFSK 

 

 

A-IV Resultados del docking molecular. 

La Figura 1 muestra los resultados del docking entre CYP1A1 humano con flavona. Se 

observa al ligando en el sitio catalítico junto al grupo hemo.  La unión es posible debido a 
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las interacciones hidrofóbicas (IH) representadas por líneas punteadas negras con 4 

residuos de aminoácidos (Ile-286, Ala-317, Phe-224 y 258). Además de dos apilamientos de 

anillos aromáticos, (líneas punteadas rojas), entre los anillos C y B de la flavona con Phe-224 

y Phe-123, respectivamente. También se observa que la conformación energética más 

favorable para la flavona, -12.20 kcal/mol, incluye la rotación del enlace C2-C1’ que conecta 

el anillo B, el cual se observa oblicuo respecto al resto de la estructura planar. 

 

 
Figura A1. Docking CYP1A1 humano con flavona. Rosa: grupo hemo; azul cian: flavona; verde: aminoácidos de 

interacción; líneas negras punteadas: interacción hidrofóbica; líneas rojas punteadas: apilamiento de anillos 

aromáticos. 

 

La Figura 2 muestra los resultados del docking entre CYP1A2 humano con flavona. Se 

observan interacciones hidrofóbicas con 8 aminoácidos (Thr-124, 321, Phe-125, 226, Ala-

317, Leu-382, 497 y Ile-386), y un enlace de hidrógeno con Asp-320 (línea azul gruesa). La 

estructura de la flavona presenta su estructura planar sin rotación en el enlace C2-C1’, 

adoptando la conformación energética más favorable de -11.90 kcal/mol. 
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Figura A2. Acoplamiento entre CYP1A2 humano con flavona. Rosa: grupo hemo; azul cian: flavona; verde: 

aminoácidos de interacción; líneas negras punteadas: interacción hidrofóbica; líneas rojas punteadas: 

apilamiento de anillos aromáticos. 

 

La Figura 3 muestra los resultados del docking entre AHR humano con flavona. Se observan 

interacciones hidrofóbicas de 6 residuos de aminoácidos (Ile-139, Phe-41, 68, Tyr-61, 122 y 

Pro-40) con la flavona cuyo enlace C2-C1’ que conecta con el anillo B presenta una torsión 

de ~45° casi perpendicular respecto al resto de la molécula formando una unión de -8.10 

kcal/mol con AHR. 

 

Figura A3. Acoplamiento entre AHR de humano con flavona. Azul cian: flavona; verde: aminoácidos de 

interacción; línea punteada: interacciones hidrofóbicas. 


